
 

  
 

Apex Sketch v7 

Toolbars & Panels  



Apex Sketch Version 7 – User Interface 

The Apex Sketch User Interface (UI) offers a familiar look for existing users with a bevy of new features 
and functionality. If you’re new to Apex, don’t let all the buttons and icons worry you. You’ll soon learn 
the basics of drawing and see how easy Apex is to use. But before you jump to the tutorials, take a little 
time to get to know the components that make up the Apex Sketch v7 UI.  

 

 

 

 

Apex Sketch v7 User Interface 

 

1 Ribbon Menu 8 Heads Up Display (HUD) 
2 Quick Access Toolbar (QAT) 9 Zoom & Scale Controls 
3 Title Bar 10 Canvas/View Tools 
4 Window Controls 11 Library Tools 
5 Panel System 12 Drawing Tools 
6 Bluetooth & Ink Indicator 13 Selection & Pan Tools 
7 Sketch Page Indicator 14 Drawing Port 

 

  

                                                                                                                                                                          

 

                                                                                                                                                                    

 

 
 

 
 

 

 
 

 

 

 



The Ribbon Bar 

The new Ribbon Bar in Apex Sketch v7 is simple to use, but you need to be aware of a few things to get 
the maximum benefit from this component. At first glance, the menus look no different than any other 
Windows application. 

However, once you access one of the “menus”, you’ll quickly notice the difference. The ribbon bar has a 
lot more to offer than traditional pull-down menus. All the functions are placed in a horizontal fashion 
giving access to your tools with minimal intrusion of your work space.  

Note: To hide the Ribbon Menu at any time, you may double-click (or double-tap) the menu tab. This 
places the Ribbon in an alternative mode that will “auto-hide” after you have selected a menu item. 

File Menu 

The File Menu consists of system type operations that pertain to the actual Sketch Files themselves. This 
is also where you will find other pertinent functions such Import/Export and Print. 

 

 

 

New (CTRL + N): Choose this option when you want to begin a new sketch file. This 
action will immediately open an empty sketch file. If you haven’t saved your current 
sketch file, you will be prompted to save your work before continuing. 
 

 

 
 

Open (F3): Use Open if you wish to open an existing sketch file. Doing so will launch 
the File open dialog and display the Open Files directory. 
 

 

 
 

Save (F2): When you’re ready to save your work, choose this option. If you haven’t 
previously saved your sketch, the File Save dialog will open and display the Save File 
directory where you will be prompted to give your sketch a name. 
 

 

 
Save As: If you’d like to save your sketch file with a different name or save it in different 
file format such as v5.x for use with Apex v5.x, choose this option. 
 

 

 
 

Import: Allows you to import a file which will take on all the subject information 
properties as well as the file name of the current sketch you are working on. 
 

 

 
 
 

Export File (CTRL + F12): Export File allows you to save your sketch file with a different 
name or save it in a different file format such as v5.x for compatibility with version 
Apex v5.x. You may export your sketch files in a variety of image formats. 
 

 

 
 

E-mail Apex: This option helps to send a message to the Technical Support with any 
questions you may have. 

 



File Menu (continued) 
 

 
 

Print: Print will send your sketch file to the printer of your choice. There are several 
options to choose from. Print Setup, Page Layout and Print PDF. 
 

 

 
 

Print Preview: This option allows you to preview how your sketch will look when 
printed before actually sending it to your printer. 
 

 

 
 

 

Print Options: Choosing this option will open the Printer Setup dialog where you can 
choose your printer along with other settings pertaining to the printed output of your 
sketch files. 
 

 

 
 

Page Layout: Page Layout provides several options when running Apex Sketch v7. You 
may choose from a variety of page sizes and styles to match your own preferences 
and/or requirements. 
 

 
 

 

Options: Choosing Options from the file menu will open the Configuration & Settings 
dialog which allows you to tailor Apex Sketch v7 around your own needs and 
preferences. 
 

 
 

 
 

Exit: This button will close Apex Sketch v7 prompting you to save your sketch file if 
you haven’t already done so. If Apex Sketch was launched via integration, you will be 
returned to the calling application. 

 

Note: You may have noticed the MRU (Most Recently Used) contained within the file menu although it 
won’t be apparent until you have created/edited a few sketches. The MRU lists the most recent sketch files 
you were working with, giving you the added convenience of quickly locating and opening them should 
you need to. 

 

Home Menu 
The Home Menu is the “main” menu you will use for most of the operations used within Apex Sketch 
v7. 

 

 
 

Cut (CTRL + X): The Cut function removes the selected item from view and stores it in 
the Windows Clipboard. 
 

 

 
 

Copy (CTRL + C): The Copy function works much the same as Cut with the exception 
that it does not remove the selected item from view. 
 

 

 
 

Paste (CTRL + V): Paste will place the object (stored in the Windows Clipboard) onto 
the drawing port. Paste can be used multiple times as well as a new location (i.e. new 
page). 



Home Menu (continued) 

 

 

Select All (CTRL + A): As the name implies, choosing this function will select all 
items contained within the active sketch page. This function is typically used for 
global changes (i.e. font or line styles), copy/paste and/or deletion. 
 

 

 
 

Select: This function allows you to specify what type of entity to select. Once 
chosen, all of the entities (with the exception of Select Area) of that type will be 
highlighted within the drawing port for the active page. 
 

 
 
 
 

Select All Areas: This allows you to select all drawn/defined areas 
contained on the active sketch page. This is helpful when making global 
changed to line styles, color and/or fill patterns. 
 

 
 
 

Select All Text Labels: Allows you to select all Text Labels within your 
sketch. This is helpful when making global font changes and/or mass 
deletion. 
 

 
 

 
 

Select All Dimensions: Allows you to select all dimensions contained 
within the active sketch page. Much like Select All Text, this is helpful 
when making global changes to all the dimension’s font style as well as 
mass deletion. 
 

 
 
 
 

Select All Symbols: Allows you to select all symbols contained within 
the active sketch page. When needing to remove symbols from the 
sketch, this is the quickest approach to selecting them all for deletion. 
 

 
 

 
 

Select All Free Form Lines: This operation will highlight all free form 
(non-calculation) lines contained within the active sketch page. This is 
helpful when removing them from the sketch and/or globally changing 
their line style properties. 
 

 

 

Delete Selected: Clicking (or tapping) Delete Selected will remove the selected 
item from the sketch. This function can be performed on single or multi-selected 
items. 
 

 

 
 

Undo: Will undo the last action performed. This is helpful when making a mistake 
and you’d like to return to the previous state. 
 

 

 

Redo: This action will Redo the last Undo. For example, if you draw a line and 
you perform an Undo the line will be removed. Using Redo will redraw the line 
once again. 

 

  



Home Menu (continued) 

 

 
Rotate Sketch: Although you can rotate individually selected items, Rotate 
Sketch allows you rotate the entire contents of the active page. 
 

 

 
 

Flip Sketch: This function allows to specify how you would like to flip the sketch. 
Although you can flip individually selected items, Flip Sketch allows you to flip 
the entire contents of the active page. 
 

 

 
 

Flip Top to Bottom: This function will flip the entire sketch from top to 
bottom in the drawing port. 

 

 
 

Flip Left to Right: This function will flip the entire sketch from left to 
right in the drawing port. 
 

 
 

Draw Color: When you need to distinguish your current drawing color from 
other drawn lines, using this function allows you to specify a color you wish to 
draw. Draw Color is temporary. Once the area is defined, all lines will change to 
match the area properties contained within the area definition. 
 

 
 

 

Subject Information: This function will display the Subject Information 
pertaining to the current sketch file. This information is typically transferred from 
the calling application and can also be manually edited if/when Apex Sketch is 
used in a stand-alone fashion. 
 

 
 

 

Area Attributes: Allows you to create & edit attribute (data collection) data for 
each area drawn within your sketch. This information is saved with each sketch 
file and may be gathered (parsed) by the calling application (provided Apex 
Sketch was launched via integration). 
 

 

 
Extended Data: Contact Apex at 1-800-858-9958 for more info on Extended 
Data. 
 

 

 

View Menu 
The view menu contains those functions that primarily have to do with what you see and how you see 
them in your drawing port. There are also a couple of functions that allow you to physically change 
the appearance of your user-interface. 

  



View Menu (continued) 

 

 

 

Mini-Map: Provides you with an alternative view of your sketch within a separate 
window. This tool is helpful when needing to work in a “close-up”, detailed view of 
your sketch while maintaining a view of the “overall”. 
 

 
 

 

View Calcs: Will open a panel on the right side of the Apex Sketch interface providing 
a summary breakdown of individual area calculations while totaling Gross Living and 
Building Areas below. Calculations include Area, Base Area, Factor, Net Area and 
Perimeter for each defined area. 
 

      

        
 

Previous Page: This option will change views to display the previous page in your 
sketch file. If no previous page exists, you will be prompted to “insert” a sketch page. 
 

 

  
Next Page: This option will change views to display the next page in your sketch file. 
If no page exists, you will be prompted to “add” a sketch page. 
 

 
 

First Page: This option will change views to display the first page in your sketch file. 

 
 

Last Page: This option will change views to display the last page in your sketch file. 

 
 

Add Page: This function will add a page to your sketch file immediately after the active 
page. For example. If your active page is Page 2 of 4 pages, choosing this function will 
effectively “insert” a new page immediately after Page 2 and advance the display to 
the new page. 
 

 

 
 

Delete Page: Will remove the active page from the sketch file. All remaining pages 
will be renumbered accordingly. 
 

 

 
 

Themes: Allows you to choose from three separate themes base on personal 
preference. However, we have observed that some themes (due to coloration and 
contrast) are more visible than others in different lighting conditions (i.e. outdoor vs. 
indoor). 
 

 
 

Blue Theme: Will change the interface to display the blue theme. 

 
 

Dark Theme: Will change the interface to display the dark theme. 

 
 

Light Theme: Will change the interface to display the light theme. 

 

 



View Menu (continued) 

 

 

 

Window: This allows you to specify a Window size. Although this is not used often, it 
can be helpful when needing to create a specific size window to sketch in when 
managing multiple applications at once. 
 

 

 
 

Apply: This function allows you to apply a current setting to legacy sketch files. This 
is very helpful in keeping all of your sketches uniform and consistent. 
 

 
 

Precision and Suffix: This will apply the current suffix settings and 
precision (decimal places) to all dimensions contained in the sketch. 
 

 
 

Area Code Table Settings: This allows you to select all drawn/defined 
areas contained on the active sketch page. This is helpful when making 
global changed to line styles, color and/or fill patterns. 
 

 
 

Cycle Dimensions: This allows you to change the location of Dimensions 
within the sketch to Inside, Outside, or Hidden by repeating the 
command. 
 

 
 

Re-Post Dimensions: 
  
 

 
 

Re-Post Labels:  
 
 

 

 

Grid On/Off: Allows you to turn on/off the grid for added visual aid while drawing. 
By default, the Grid is configured to match the Step (whole feet) and can be configured 
to display Imperial or Metric based on your preferences. 
 

 

 
 

Filter: Allows you to hide or show various classes of items withing your sketches with- 
out actually removing them from the file itself. This gives you the ability to control the 
detail level in your sketches without affecting the original sketch file and its contents. 

 

 
  



Tools Menu (continued) 

The Tools Menu, contains functions pertaining to program configuration and Bluetooth connectivity. 

 

 

 

Disto Connect: Choosing this option will automatically begin polling for nearby 
DISTO™ laser meters. Provided your DISTO is equipped with Bluetooth, is on and 
Bluetooth is activated, Apex Sketch v7 will automatically detect and connect with your 
DISTO. 
 

 
 

Disto Disconnect: Will terminate the Bluetooth connection with your DISTO. 
 
 

 

 
 

Options: Choosing Options will open the Configuration & Settings dialog which 
allows you to tailor Apex Sketch v7 around your own needs and preferences. 

 

Help Menu  

The Help Menu contains those functions that allow you to view this reference material as well as other 
helpful options designed to assist you with Apex Sketch v7. If you are unable to find the answers to 
your questions from this menu, please don’t hesitate to call us at 800-858-9958 and we’ll do our best 
to assist you with all of your sketching needs. 

 

 

 
Email Support: This option helps to send a message to Technical Support with any 
questions you may have. 
 

 

 
 

Remote Assistance: This options allows an Apex Support team member to log in 
remotely and see what you area seeing live in real time. 
 

 

 
 

Online User Guide: This is the option you choose to open the Apex Sketch v7 
Reference Guide. 
 

 

 

Deactivate License: Choose this option if you wish to unregister Apex Sketch v from 
your current device. This is typically done when changing to new machines and/or 
managing licenses between computers. 
 

 

 
Activate Module: Choose this option if you would like to register a module on the 
current device.  
 



Help Menu (continued) 

 

 

 

Deactivate Module: Choose this option if you would like to unregister a module from 
the current device. This is typically done when changing to a new machine and/or 
managing licenses between computers. 
 

 

 
 

Updates: This option will check and make sure Apex Sketch v7 is up-to-date with the 
latest version of Apex. 
 

 

 
 

About: Will provide you with helpful information when contacting Apex Technical 
Support. Having this information handy when speaking with an Apex Representative 
is very helpful. 

 

Quick Access Toolbar 

The Quick Access Toolbar (QAT) gives you the flexibility to mix and match your frequently used 
commands, making them readily available by adding them to this toolbar.  

QAT Defaults 

If you do not change anything in the QAT, the default commands are as shown below. You may 
change the QAT to contain virtually any command available in Apex Sketch v7. 

 

 

 

Quick Access Toolbar – Defaults 

 

1 Window Control 5 Print Preview 
2 Open File 6 Undo 
3 Save As 7 Redo 
4 Printer Setup 8 QAT Controls 

 

Note: You can learn more about each command in their respective sections under “The Ribbon Menu”. 

 
                                                

                                                



Drawing Toolbar 

The Drawing Toolbar is located on the left side of the program and contains all the tools needed to 
create and/or edit sketches in Apex Sketch v7. 

  

 
 

 
 

Selection/Edit Tool: This is generally used for selecting individual or multiple items 
for the purpose of editing them in some fashion. With the mouse, you must press (and 
hold) CTRL for multiple itemselection where with a pen or finger, selecting multiple 
items is inherent. 
 

 

 
 

Fence Tool: This tool allows you to drag a fence (rectangular) around objects in your 
sketch. Once you release your mouse button or lift your pen/finger, all objects fully 
contained in the fence will become selected. 
 

 

 

Lasso Tool: Like Fence, the Lasso Tool allows you to select multiple items but with far 
more precision. Simply draw around the items you wish to select and anything fully 
contained within the “lasso” will become selected. 
 

 

 

Pan: This function allow you to move your drawing canvas (along with the sketch). 
This is particularly helpful when needing to view a specific section of your sketch while 
zoomed in or to simply move your sketch to create more drawing space. 
 

 

 

Draw Exterior: This Drawing mode allows you to draw lines (typically exterior) which 
will be used for calculation purposes. Simply put, if you want/need to calculate the 
shapes you draw – this is the tool you should use. 
 

 

 
 

Draw Interior: This Drawing mode allows you to draw lines (typically interior) which 
will be used for illustration (non-calculation) purposes. This line style is generally used 
to depict interior floor plans, fence lines, property lots, streets, etc. 
 

 

 
 

Insert Vertex: A Vertex in drawing terms is a “point” in the sketch. This drawing mode 
allows you to “break/divide” lines and shapes using the same drawing methods for 
creating any line. 
 

 

 
Area Definition Library: This tool will open the Area Definition Panel from which you 
use to detect shapes and apply area attributes along with their calculation. 
 
 

 

 
Text Library: Pressing this button will open the Text Library Panel allowing you to 
annotate your sketches with (say) room labels and/or other notes. 
 

 



Drawing Toolbar (continued) 

 

 

 

Symbol Library: This function will open the Symbol Library Panel where you can 
choose from over 200 individually drawn and scaled symbols to add to your property 
sketches for additional detail. 
 

 

 
Touch: This will open the Touch Panel which is designed for mobile users who wish to 
draw in the field with their Windows Tablet. This will only be visible if touch is enabled. 
 

 

 

Sketch Gro-Refrenceing: This tool does not open a dialog, but does launch the Geo-
Referencing process by which you will choose locations in your sketch to reference 
data from your GIS System. This will only be visible in Apex Sketch v7 PRO. 

 

Panel System 

The Panel System in Apex Sketch v7 is designed to provide quick and easy access to libraries that 
allow you to define areas, annotate your sketches and view calculations. Included in the panel system 
is a special touch panel that allows mobile users to draw floor plans in the field using only their finger 
to create/verify measurements while on site. 

    

     
Define Area Text Labels Symbols Calculations Touch Panel 

  



Define Area Panel 
This panel is used to apply an Area Definition to a closed shape in order to calculate its area and apply 
any associated area properties (i.e. Line Styles, Color and Fill Patterns). This panel supports drag and 
drop by which you can drag Area Definitions into the shape of your choice, drop it and the 
Calculations will be done instantly. Below is a brief description of the elements that make up the Area 
Definition Panel. 

 

 

 

 

 Expanded Main Area Category: The Main Area Type is the 
leftmost label in the list (tree). When expanded, a “-“ 
(minus) will be displayed to the left of the label. To collapse 
a category, click (or tap) the “-“ which will remove the sub-
areas from display. 
 

 

 
 

Sub Areas: These are the Area Definitions that belong to 
the Main Area Type and are typically organized in such a 
manner as they share similar attributes. 
 

 

 Collapsed Main Area Category: When a Main Area 
Category is collapsed, a “+” (plus) will be displayed which 
also indicates that Sub Areas exist. To expand a category, 
click (or tap) the “+” which will display the associated Sub 
Areas. 
 

 

 Main Area Type: This is similar to the Main Area 
Categories, but does not have any Sub Area associated as 
is indicated by the absence of a “+” or “-“. 
 

 

 Apply Button: This is used to apply an Area Definition to 
a selected shape 
 

 

 Auto-Post Options: These controls allow you to specify 
what should appear once the Area is defined. 
 

 

 Area Preview: As you select Area Definitions, the Area 
Preview will update illustrating the Area Attributes that will 
be applied. 
 

 

 Edit Button: This button accesses the Area Definitions 
Configuration which allows you to modify existing Area 
Definitions or create new Area Definitions. 
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Text Label Panel 
The Text Label Panel provides you with access to your most frequently used labels allowing you to 
quickly annotate your floor plan sketches. A default set of labels is provided which can be edited to 
match your requirements and/or preferences. What follows is a brief description of the elements that 
make up the Text Library Panel. 

 

 
  

 

 

 

 Text Input Panel: The input panel provided is primarily 
used when the Text Label you wish to use does not exist in 
the list. This is helpful for placing Text Labels that are rarely 
used. Otherwise, we recommend adding the Text Label to 
the list for convenience. 
 

 

 Text Label List: This list displays the labels that are 
currently contained in your library. This list is always 
displayed in alphabetical order. 
 

 

 Edit: This is used when editing the list of labels in your 
library. 
 

 

 Rolodex Control: This set of buttons is most helpful when 
managing large lists of text labels allowing you to display 
only those labels that match the filter as designated on 
each button. 
 

 
 

 
    

 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Symbol Library Panel 
The Symbol Library in Apex Sketch v7 contains precisely drawn Symbols which will scale to any sketch 
you create. As you might imagine, they can also be resized and edited to your liking. What follows is a 
brief description of the elements that make up the Symbol Library Panel. 

 

 

 

 

 Symbol Category: This drop down allows you to select a 
category of Symbols from which to choose. Breaking the 
symbols up into categories makes the 200+ Symbols far 
easier to manager. The Favorites category open by default. 
Knowing this, you may add to or remove symbols from this 
library to display only those you typically use. 
 

 

 Symbol Library: Once a category is chosen, the list below 
will populate with the symbols contained within that 
directory. 
 

 

 Symbol Preview: As symbols are selected as shown by the 
highlight to the left, a preview of the symbol is displayed at 
the bottom of the panel making it easier and quicker to 
verify the symbol you want to use. 
 

 

 Organize: This allows you to modify which symbols show 
up in each category.  
 

 

 Scroll Bar: The presence of a scroll bar indicates there are 
more Symbols in this category than can be listen in this 
panel. Use the scroll bar to view more symbols in the 
displayed category. 
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Area Calculation Panel 
This panel allows you to view the calculations of all defined areas drawn in your floor plan. This is 
presented in a tree format which can be expanded or collapsed to expose only those elements and/or 
areas you wish to review. What follows is a brief description of the elements that make up the Area 
Calculations Panel. 

 

 

 

 

 Expand/Collapse All: Clicking Expand All will open all 
additional Area Calculations on the current page and 
display them in this panel. Clicking Collapse All will close all 
additional Area Calculations on the current page and 
display only the adjusted calculations for each area in this 
panel. 
 

 

 Expanded Area Calcs: First Floor (as illustrated to the left) 
is an example of an expanded calculation tree. Base Area, 
Factor, Net Area and Perimeter are displayed along with the 
overall calculation. 
 

 

 Collapsed Area Calcs: Both of the P/P (Porch/Patio as 
illustrated to the left) areas are examples of collapsed 
calculation tree. In this state, only the adjusted calculation 
will be displayed. 
 

 

 Calculation Details: Provides you with a more detailed 
breakdown of each area and how it is being calculated.  
 

 

 Calculation Summary: Calculation Summary lists the 
number of defined areas contained on the current page 
along with the combined calculations for any Living and/or 
Building areas. In this illustration, both First and Second 
floors are included in this total. Additionally, since no 
defined Buildings (typically reserved for commercial 
purposes) exist, the Summary lists this value as zero. 
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Touch Panel 
The Touch Panel is specifically designed for those who have Touch Only Windows tablets or users who 
simply prefer the touch method of drawing over pen (inking). What follows is a brief description of the 
elements that make up the Touch Panel.  

 

 

 

 

 Distance Display: As you input information from the 
number pad (8), the information is displayed in this field. 
This field also displays Turn information.  
 

 

 

 Angle Left & Right: Used in the “Turn” function for 
drawing angles, these buttons allow you to specify the 
direction of the angle. 
 

 

 Curve Left & Right: Allows you to create a curve from the 
active line. Each tap will “grow” or “shrink” the curve 
depending on the direction of the curve. 
 

 

 Shift & Control: These are modifier buttons that assist you 
with drawing and/or alignment functions. 
 

 

 Delete & Insert: Delete and Insert allow you to delete lines 
to correct mistakes and insert those you previously deleted. 
 

 

 ENTER Button: ENTER is used to “accept” and anchor the 
line once you are satisfied with its dimension and/or 
orientation. 
 

 

 Direction Pad: The Direction Pad is typically used in 
conjunction with the number pad for distance and direction 
drawing. However, when no value is input, pressing an 
arrow button will move the cursor a single unit in the given 
direction. The center button in the Direction Pad is Jump 
which will move the cursor to the nearest endpoint of a line. 
 

 

 Number Pad: This pad is used to enter measurements 
typically followed by a direction specified on the direction 
pad. As you tap the number pad, the Distance Display (1) 
will show the value. 

 
 

 

    

 
 

 

 
 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

Zoom & Scale Controls  
Zoom & Scale may seem redundant on the surface, but each function are separate and different in their 
own regard. To make things more clear, Zoom should be considered a “View” property and Scale be 
considered a “Size” property. 

 

Zoom Slider 
Located at the bottom left of the interface, the Zoom Slider is used to increase or decrease your view 
in the drawing port. Zooming in will make the sketch larger giving you a close-up view how much you 
can see in the Drawing Port. Zooming out will make the sketch smaller allowing you a more global view 
of your sketch the further you continue. 

 

 
 

 
 

 

 
Zoom Out Button: Pressing this button will Zoom Out (make smaller) in increments of 10%.  
 

 
 

 

 
Zoom Slider Control: Dragging this control will increase (step) in 10% increments. 
 

 
 

 

 
Zoom In Button: Pressing this button will Zoom In (make larger) in increments of 10%. 
 

 
 

 

 
Zoom Percent: This displays the current Zoom percentage. 
 

 

 

Note: Zooming in or out can also be accomplished by rolling your mouse forward (Zoom In) and backward 
(Zoom Out). In order to do this, you must be in Select Mode or you drawing cursor must be in an “Up” 
State (not drawing).  

 

  

                                                          



Zoom & Scale Controls (continued) 

Scale Control 
As we’ve mentioned, Scale does not affect your Zoom level, but it does have an impact on the “Size” of 
the sketch which does appear larger or smaller depending on the scale you specify. While on screen, 
Scale isn’t much different than Zoom. However, when it comes to output (i.e. printing) the use for scale 
becomes more evident. 

 

 
 

 
 

 

 
Unit of Measure: This display indicates which unit of measure is being applied to your sketch. 
In Imperial the ratio is 1 inch to feet. In Metric, this is 1 meter to meters. 
 

 

 
 

 

 
Scale Input Field: Input the number of units (feet or meters) you wish to rescale your sketch. 
 

 

 

Note: Keep in mind, the larger the number you input, the smaller the sketch will appear in your drawing 
port. Conversely the smaller the number, the larger your sketch will appear. 

 

Canvas/View Tools 

Like the Zoom & Scale Controls, these tools also allow you to change what you see on your screen. The 
following is a description of each of these tools. 

 

 

 

 

Center (C): This function will which will center the sketch in the Drawing Port. This is 
convenient while drawing as it allows you to quickly adjust your sketch whenever you draw 
off of the drawing port keeping it in view. 
 

 
 

 

Center & Fit (Shift C): Although the Center function is valuable, sometimes, centering your 
sketch isn’t enough as your sketch may be too large (or too small) in its current size. This 
function will Center and Fit the sketch (by its extents) in the drawing port bringing the entire 
sketch into view. 
 

                      



Canvas/View Tools (continued) 

 

 
 

Fence Zoom: Allows you to show or hide the grid in the drawing port. Although the grid is 
an excellent tool for viewing alignment, you might find (because of the drawing and 
alignment tools available in Apex Sketch) the grid to be unnecessary.  
 

 
 

Grid On/Off (G): Allows you to show or hide the grid in the drawing port. Although the grid 
is an excellent tool for viewing alignment, you might find (because of the drawing and 
alignment tools available in Apex Sketch) the grid to be unnecessary.  
 

 

 
Snap On/Off: Allows you to turn on or off the snapping of the cursor while sketching in Apex. 
This will also turn off alignment indicators while sketching. 
 
 

 

 

Filter: Allows you to hide or show various classes of items withing your sketches with- out 
actually removing them from the file itself. This gives you the ability to control the detail level 
in your sketches without affecting the original sketch file and its contents. 
 

 

Bluetooth Connection and Ink Disabled Indicators  

Bluetooth & Inking (disabled) Indicators provide the user with feedback regarding their current state. 
The “ON” state for Bluetooth is designated by a color glyph where the “OFF” state is designated by a 
dithered glyph. Inking will show “ON” or “OFF” depending on its state. 

 

 

 

 
 

 
or 

 

 

Bluetooth Indicator: Apex Sketch v7 supports Bluetooth connection with 
DISTO Laser Meters (Leica GeoSystems). If a connection is established the 
indicator will change from dithered to color as shown. 
 
 

 

 
 

 
or 

 

 

Ink Disabled Indicator: When Touch is enabled through Options, Inking 
(active pen) is disabled as a convenience to the user. When this occurs, 
the glyph will change from On to Off as show to the left. 
 

 

  



Sketch Page Indicator  

The Sketch Page Indicator offers more than visual feedback of the page you’re working with. It’s also 
how you navigate, insert and add new pages. Apex Sketch allows unlimited number of pages per 
sketch file. Whether it’s splitting multi-story buildings or managing your scale by separating structures 
across multiple pages, this extended functionality provides you with the flexibility you need when 
laying out your floor plans and property sketches.  

 

 

 

Sketch Page Indicator 

1 Previous/Insert Page 3 Total Pages 
2 Active Page 4 Next/Add Page 

 

 

Adding & Inserting Pages  
Whenever you wish to add or insert a page to your sketch file you can do so through View>Add. 
However, while navigating, when you’ve come to the first or last page in the sketch, continuing to 
navigate left will prompt you to insert a page and navigating right on the last page will prompt you to 
add a page. 

 

 

 
Insert Page Dialog 

 
Add Page Dialog 
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